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619 Placement (B6) Data: Division Analysis 

Analyzing your division’s preschool special education placement data is not difficult. It can actually 
be fun. (Ok, maybe not everyone’s definition of fun.) If you haven’t played with your data in Excel 
here is a step-by-step guide. Although it may not become your new favorite hobby, it is (honestly) 
relatively easy to use and can provide you some insights. (Hint: There are tons of free “how to” Excel 
videos on line, YouTube, etc. If you get stuck, “Google it.”) 
 

STEP ONE:  GET YOUR 619 DATA  

1. Find the person in your agency that can supply you 
with the data you seek. (You may also be able to get 
your data “back” from the VDOE. Check with your 
supervisor to find out who can make this request.) 
 

Student level data to request 

a. Year (school year, or child count year) 
b. Race (If variables are numeric codes, ask them to 

translate to text. Or you can do it, see page 2.) 
1. American Indian/Alaska Native 
2. Asian 
3. Black/African American 
4. Hispanic 
5. White 
6. Native Hawaiian/Other Pacific Islander 
7. 2 or more races 

c. Gender (M or F) 
d. Grade (PK or K) 
e. Primary Disability (You could ask for secondary 

disability if desired. While informative for some 
analyses, it makes analyses more complex.) 

1. Intellectual Disability 
2. Hearing Impaired 
3. Speech/Lang Impairment 
4. Visual Impairment 
5. Emotional Disturbance 
6. Orthopedic Impairment 
7. Other Health Impairment 
8. Specific Learning Disability 
9. Deaf Blind 
10. Multiple Disabilities 
11. Autism 
12. Traumatic Brain Injury 
13. Developmental Delay 

f. Placement 
1. Regular Early Childhood Program 
2. Special Ed Separate Class 
3. Special Ed Separate School 
4. Special Ed Residential Facility 
5. Home 
6. Service Provider Location 

g. Birth date 
h. Age as of child count date for that school year 
i. Age at Entry (If available) 
j. Entry Date (Age at entry can be calculated) 
k. School or Building  
l. ESL, Migrant, Head Start, etc.: Any other data that 

may inform your work. 

2. If that person knows the data pretty well talk to 
them first about what you want to do. Examples:  

a. Look at 619 placement data across schools 
b. Look at longitudinal (trend) data 
c. Look for differences in placement across 

populations  

They may have additional suggestions and may be 
able to assist you with Excel if you get stuck. 

 

3. Let them know you want to “play with the data” in 
Excel and would like:  

a. Child-level record data 
b. Multiple years of data (3 years is an 

acceptable minimum for trends) 
c. All the data on a single Excel worksheet 

(“tab”) or at least each year’s data on a 
single sheet (that you can append together) 

4. Request easy to understand column headers. This 
may require someone to translate and edit what 
can sometimes be truncated field names.  
 
Alternatively, if there is a data dictionary for your 
local system, you can spend time reading it to find 
all the correct field names, definitions, etc. and 
bring that list to them. However, chances are they 
can make it happen quicker than your reading the 
data dictionary. IMPORTANT: Be sure that the 
person supplying the data understands all the 
variables you want. Spending a few minutes 
together going over the list to confirm a mutual 
understanding is time well spent.  
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STEP TWO: PREPARE YOUR 619 DATA  

Your requested data will probably come in something like the view below (with rows of student level data 
beneath these column headers.) Preparing your data for Excel can take a bit of work (this is the hardest part).  
Again, use other resources whenever it makes sense, such as someone who knows Excel and/or online 
resources (see Step Four). If you’ve been given columns of data you won’t use, simply delete the column. 
  

Child 
Name 

or other 
PII 

Year  
Race/ 

Ethnicity 
Gender  

Grade 
Level 

Primary 
Disability 

Placement 
Birth 
date   

Entry 
Date   

Building 
Code 

ESL 
Service

s  

MISSING: 
Age (in 

Months) 
at Entry s  

Count 

Student 1 2015-16 White F K VI 
Reg EC 

Prog 
10-18-
2014 

03-
21-

2015 
00987 N 

To be 
calculated 

1 

Student 2 2015-16 Hispanic M PK AUT Home 
12-08-
2014 

12-
11-

2015 
00654 N See text 1 

 

Some things to consider:  

1. You may have requested student level, personally 
identifiable information (First Name, Last Name, ID 
Code, etc.) depending on your need. These fields are 
not necessary for most analyses so were not listed 
above. 
  

2. The order of the columns is not important. Columns can 
easily be moved (and added) in Excel. 
 

3. Because much of the work you’ll be asking of Excel is 
counting instances (e.g., number of students by race in 
various placements) it is handy to have a column that 
simply has the number one for each record (row).  Add 
a column called ‘Count’ in Excel. Put the number 1 in 
the top cell (probably row 2). Then double click the tiny 
box in the lower right corner of the cell on row 2 with the 
number 1 in it.  It will copy this value to all rows below. 

 
4. This paragraph is for someone with moderate 

comfort with Excel. If you requested ‘Age at Entry’ but 
it was not available, here is a calculation you can use in 
Excel to have it calculate the number of months 
between two dates:  

a. Add a new column entitled Age in Months at Entry 
b. In the top data cell of that column (here assumed as 

row 2) add this function:  
=(YEAR(C2)-YEAR(E2))*12+MONTH(C2)-MONTH(E2)  

c. Where column C is ‘Entry Date’ and column E 
is ‘Date of Birth’. 

d. Copy the formula down remaining rows to 
provide the age in months for each record. 
 

5. Many people find it easier, more intuitive, to work with 
cells that have descriptive text rather than numeric 
“codes.” Text codes are easier to read when selecting 
variables and when Excel populates charts and tables. 

(Otherwise you’d see a code number, e.g., “86,” as the 
row or column title in a table, or under a bar in a chart. It 
would be much more intuitive if the label read what the 
code meant, e.g., AUT, Service Provider, or 
Washington Elem School.) If you received text in all the 
columns you need great. However, if some columns 
have codes and you’d prefer text, you can work with 
Excel to change any numeric code to text. First find a 
key so you know what the numeric codes represent. 
(There are multiple ways to do change codes to text. 
One way is briefly described in the paragraph below. 
Another is to have someone in the office show you 
how.)  
 
This paragraph is for someone with moderate 
comfort with Excel. A nested “IF” function in Excel is 
one way to change cell content into something else. For 
this example, suppose in column A heading is Color.  
But the colors were given numeric codes and we’d 
prefer the actual text, in this case the color name. We 
want to change the number 1 to yellow, 2 to green, and 
3 to purple. (You are not limited to three nestings of IF 
statements, only in this example.) In Excel we could 
nest IF statements to change numbers to the name of 
the color. For the above, the nested IF function would 
be:  

       =IF(A2=1,"yellow",IF(A2=2,”green",IF(A2=3,"purple”,FALSE)))  

 
Anything NOT a 1, 2, 3 would come back as FALSE (or 
whatever you want it to be.) These can get tricky, 
especially when many IF statements are nested 
together for changing a lot of codes. Check videos or 
ask someone in the office who can help you. 
 

6. Save your file frequently. Especially if you are new to 
Excel, you may want to save different iterations along 
the way. So that you can go back to your last version if 
needed. (Not that this author has ever had to do that!!) 
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STEP THREE: SET UP YOUR WORK WITH A PIVOT TABLE IN EXCEL 

Once your data are in Excel using a pivot chart and pivot 
table is an easy way to “play” with your data. Pivot charts 
and tables provide both a table with rows and columns of 
numbers, and generate a visual chart showing the data. You 
can further refine your data views, capture them for later 
use, or create new data views very quickly. The remainder of 
this section describes how to put your data into a pivot chart 
and table. Remember there are lots of videos on this.  

 

Before you get started, make sure your data is organized 
in a tabular format, with no blank rows or columns. Ideally, 
you’ll have a fully populated Excel table similar to the above 
example. Data in each column should be the same type. In 
other words, don’t mix dates and text in the same column. 

 

PivotTables work on a snapshot of your data, called so your 
actual data doesn't get altered in any way. 

 

1. Highlight the data in your worksheet. With one click you 
can click the cell in the upper left corner above row #1 
and to the left of the letter A. 

 
2. Below is based on MS Excel 2013, but earlier versions 

are similar. Google your version number along with: 
“create pivot chart” for steps specific to your version.  

 

On the ribbon, go to Insert > Charts > PivotChart>Pivot 
Chart & PivotTable (you could just select pivot table, but the 
charting function is recommended and just as easy). 

 

(If you're using Excel for Mac 2011 and earlier, the 
PivotTable button is on the Data tab in the Analysis group.) 

 

3. Excel will display the Create PivotTable dialog box with 
your range or table name selected. 

 
4. In the Choose where you want the PivotTable report to 

be placed section, select New Worksheet as shown 
below.  

 

 
 

5. Note that you could include multiple tables or data 
sources in your PivotTable, by clicking Add this data to 
the Data Model check box—but this is not 
recommended, and not needed if all your data are in 
one worksheet already. 

 
6. Click OK, and Excel will create a new worksheet with a 

blank PivotTable, and display the PivotTable Fieldslist. 
Your original data sheet is not altered. 
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STEP FOUR: INVESTIGATE YOUR DATA   

Now the fun begins. The pivot lets you manipulate 
your data in different ways showing you what 
relationships looks like. Try this exercise (based on 
the field names above) to look at your Placement 
data in relation to your Primary Disability data. 

 

1. On the new pivotchart worksheet that opened,  
your data columns are listed in the top right with 
checkboxes. Put a check in the “COUNT” box. 
Then drag the word COUNT down to the lower 
right of the pivot worksheet and drop it in the area 
with the word “VALUES” (proceeded by the Σ, the 
summation sign.) A single column (bar) should 
have appeared in the chart and the Y axis (the 
vertical axis) will have populated accordingly 
showing you the total number of records. (For 
added fun, mouse over it to see the N for the 
actual number of records.)  

 
2. Our real investigation is to look at the relationship 

between PLACEMENT and PRIMARY 
DISABILITY. So click PLACEMENT in the top right 
(leave Count where it is). Now move the word 
PLACEMENT down to where is says LEGEND and 
drop it.   

 
3. What should have happened is that all of your 

records that were in a solitary column are now 
divided across multiple columns with each 
representing the number of records assigned that 
PLACEMENT type. So you have one for Reg Early 
Childhood Program, one for Separate Class, one 
for Home, etc.  

 
4. (If you have only one year of data, skip this step.) 

If you want to look at just one year of 
PLACEMENT data at a time (we’ll get to 
PRIMARY DISABILITY in the next step!) then go 
to YEAR in the top right. Click it, but don’t move it. 
You’ll see a filter icon (funnel) to the right of the 
word YEAR. Click the down triangle to the right of 
the icon and you’ll see the years of data you have. 
Click any one year you want to see. The data in 
the chart (and the corresponding table that is 
always showing) changes and now you are looking 
at a graph of your PLACEMENT data for the YEAR 
you selected.  

5. Now let’s look at this one year of PLACEMENT 
data by PRIMARY DISABILITY. Because we want 
to display the data in a way that supports easy 
comparisons of these two variables we are going 
to change the chart type. You want make sure the 
chart with the bars is highlighted with small little 
boxes around the outside perimeter. A total of 
eight little boxes, three on each side. (You can 
also highlight the actual chart within the window 
with the chart.) Once you see the little squares go 
to the ribbon and go to Insert > Charts > 

Recommended Charts and you’ll where you can view 
different chart types. This is an area that you can 
explore to find the view that you believe best fits your 
data. For this example select the word Column in the 
list to the left and then select on top the 100% stacked 
column type. Then hit OK. 
 

6. What should have happened is that the separate 
columns of PLACEMENT data should have 
stacked on top of each other and the Y axis should 
have turned to %. The PLACMENT data should be 
different colors (and there should be a key that 
populated earlier to define the colors).  Now we 
want to add the PRIMARY DISABILITY variable.  
Really what we want is to separate out all the 
PLACEMENT data, that is already in the chart, into  
each separate PRIMARY DISABILITY. Right now 
all the records are only separated out by 
PLACEMENT and by YEAR. 

 
Put a check mark next to PRIMARY DISABILITY in 
the upper right. Bingo!  All the PLACEMENT data 
is now separated into individual groupings by each 
PRIMARY DISABILITY. Moreover, because we 
selected a 100% stacked column the display is by 
percent (not numbers). So we easily compare the 
proportional PLACEMENTS by each PRIMARY 
DISABILITY. (Of course the numbers of some 
disabilities are quite small and that must always be 
a consideration when comparing data. A 
discussion of cell size is outside the scope of this 
short handout. But a caution is in order when 
interpreting data, especially with small N sizes.)  
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STEP FIVE: DISCOVER, SHARE AND FIND THE STORY BEHIND THE NUMBERS 

PLACEMENT by PRIMARY DISABILITY is just one example of data you can investigate. Within the pivot you 
can select and deselect fields, change chart types, look at three way comparisons, develop multiyear trend 
views, copy and paste charts and tables into Word docs, develop a report for the board, etc. Pivot charts and 
tables support easy data exploration allowing you to see relationships.  If you’ve read this far hopefully you 
enjoyed enough to continue on your own.   

 

Here are some other analyses that can be replicated similar to the above example:  

a. PLACEMENT by RACE/ETHNICITY 
b. PLACEMENT by BUILDING 
c. AGE AT ENTRY by RACE/ETHNICITY 
d. DISABILITY by AGE at ENTRY 

e. PLACEMENT by GRADE 

 

Reminders:  

 Go online and learn more about pivots. Talk to others who use them. 

 When you select variables you are really deselecting others. Check your filters. (Paying close attention to 
your N size is a quick way to check that you’ve got all the expected records.)  

 (Unfortunately) Colors will not be consistent across charts. 

 You cannot break your data with a pivot. Your data remain on the other worksheet and are not changing; 
the pivot is simply “counting” your data and displaying it as you direct.  
 

As you investigate your data share it with those with a vested interest. (Suggestion: Before reporting data to 
the board, double check your findings. Have someone else who knows Excel double check your work.) Ask 
those who might know questions about the data. Is this expected? Why or why not? Do these building level 
differences make sense? What might populations might we focus on in a different way? How should we 
prioritize our work based on how we are interpreting the data? 

 

 

Resources 
 

Disclaimer: This is not a definitive source for pivot tables, pivot charts, Excel, or preschool special education 
placement data. There are lots of resources out there, a few of which are listed below.  

 

The DaSy Data Visualization Toolkit is an excellent resource to assist with data displays. 

The Center for IDEA Early Childhood Data Systems (DaSy)1 

The Early Childhood Technical Assistance Center (ECTA Centers) 

How to Learn Excel: The 10 Best Resources on the Internet  (many of which are free.) 
 

 

______________________________________________________________________________________________________________________ 

 

                                                                 

1   This handout was developed by:  DaSy (The Center for IDEA Early Childhood Data Systems), Powerful Data for 619 Cohort, Nov 4, 2016  

http://dasycenter.org/data-visualization-toolkit-tools-tips-for-presenting-data-effectively/
http://dasycenter.org/
http://ectacenter.org/
http://blog.hubspot.com/marketing/learn-excel-resources#sm.000jg55lf1azwdqjw9513lnipuy52
http://dasycenter.org/

